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SARscapeについて
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SARscape入門

SARscapeとは

• ENVIの追加モジュールであるSARscapeは、SARデー
タ処理機能をパッケージとして設計されており、ス
イスのsarmap社によって開発されています。光学セ
ンサの可視化やデータ解析に定評のあるENVI上で動
作し、GUIを提供しています。最新のSARセンサの処
理やSARデータと光学データを組み合わせて解析す
る際に、非常に有効なツールとなります。

• モジュール構成
- Basicモジュール
- Focusingモジュール
- Gamma & Gaussianモジュール
- Interferometry/Differential Interferometryモジュール
- Interferometry Stackingモジュール
- ScanSAR Interferometryモジュール
- Polarimetry/Polarimetry Interferometryモジュール

2



SARについて
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SARscape入門

SARデータとは: 

SARデータと光学データの相違点
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光学衛星

（航空写真と同じ原理）

レーダ衛星

レーダ衛星の長所

1. 雲を透過して観測可能

2. 夜間も観測可能

短所

1. 電波を見るので判読しづらい

2. 1回の観測で白黒情報のみ

光学衛星の長所

1. 太陽光が地面で反射した光を観測し見やすい

2. 1回の観測で、色情報量が多い（RGB）

短所

1. 雲を透過して観測不可能

2. 夜間も観測不可能



SARscape入門

SARデータとは

• レーダイメージングシステムの重要な特性は、光学センサと異
なり、アクティブなセンサであるという点です。レーダシステ
ムは信号を発信して地表から反射して戻ってきた信号を記録し
ます。システムそのものは、電磁気のエネルギーを発生させて
います。レーダシステムはアクティブであるため、太陽を光源
とせず、昼、夜を問わず観測を行うことができます。

SARの特徴

• 夜間観測可能

• 雲を透過する

• 白黒画像

• 表面粗度を観測

• 水面を分離しやすい

• 振幅と位相の情報を持つ

• 偏波が使える
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SARscape入門

SARの用語

以下の図に示した用語はSARデータを処理する上で、必要な用語となり、
本マニュアル内でも使用します。
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演習に入る前に:
ENVI/SARscapeインターフェース
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SARscape入門

ENVIの起動方法
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Windows10 / 11
[Start Menu] > ENVI 5.7 > ENVI 5.7

Mac
/Applications/harris/ -> ENVI5.7のアイコンを選択

Linux
ターミナルから envi_rtコマンドを入力する



SARscape入門

ENVIインターフェースについて
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メニューバー
ツールバー

レイヤマネージャ

オーバービュー

カーソル値表示 プロセスバー

ツールボックス



SARscape入門

ENVIインターフェース: メニューバー

•ファイルを開く、編集、表示に関
するツールや、ウィンドウの分割
など、インターフェース及び、画
像の基本的な操作に必要な機能を
提供します。
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SARscape入門

ENVIインターフェース: ツールバー

•ズームイン・アウトや、パン、アノテーション、ストレッチなど、表
示した画像に対して操作に関するツールをグラフィカルなアイコンで
提供します（詳細は後述します）。
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SARscape入門

ENVIインターフェース: レイヤマネージャ

•インターフェースに表示されている画像の管理
を行います。

•チェックボックスをオン/オフする事で、表示/
非表示の設定を行います。

•ファイル名上で右クリックをすると、サブメ
ニューが表示され、表示の削除やRGBコンポ
ジットの変更などが行えます。

•レイヤーマネージャの[Overview]へチェックを
入れることで、画像全体を表示します。
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SARscape入門

ENVIインターフェース:ツールボックス

• ENVI の解析機能がカテゴリごとに格納されています。検索機能が提供
されており、「Search the Toolbox」へキーワードを入力することで、
該当の機能がリスト表示されます。
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SARscape入門

ENVIインターフェース:
カーソル値表示およびプロセスバー
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地図投影法を保持した画像上でマウスを移動させると、カーソルのある場
所のピクセルに対応した地図情報が表示されます。

プロセスバーは、処理の経過を表示しています。右側にあるバツマークを
クリックすると、処理はキャンセルされます。



SARscape入門

ENVI HELPとSARscape HELP
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◼ ENVI HELP
メニューバーのHelpから起動します。

◼ SARscape HELP
ENVIのToolbox内のSARscapeのメニューからHelpを
起動します。

HTML形式のファイルを開く場合の
指定のブラウザが起動し、
対応のヘルプページが開きます。



ENVI/SARscapeの基本設定について
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SARscape入門

環境の設定: Preference

• 使用するデータへのアクセスなどを容易に行うため、環境の設定を行います。

• ENVI では、ファイルの入出力ディレクトリをあらかじめ指定することで、デフォ
ルトで指定したディレクトリを表示することが可能です。
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SARscape入門

環境の設定: Preference
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名称 機能

Input Directory 入力ファイルを指定する際に表示するインプットディレクトリの指定

Output Directory 出力ファイルを指定する際に表示するインプットディレクトリの指定

Temporary Directory 処理中に作成される、テンポラリファイルの保存先

https://www.nv5geospatialsoftware.com/docs/Preferences.html#Director

https://www.nv5geospatialsoftware.com/docs/Preferences.html#Director


SARscape入門

環境の設定: SARscapeのPreference

SARscapeの処理で使用される設定は、
SARscapeのPreferencesで行います。
• Preferences common

- DEMなどのデフォルト読込先ディレクトリやGPUの
使用設定を行うメニューです。

• Preferences specific
-各処理に使用されるパラメータのデフォルト値を
設定します。

- Load Preferencesボタンから、使用するSAR画像の
特性にあわせたパラメータのデフォルト値に変更
します。
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SARscape入門

SARscapeのPreferences specific: 設定例

• General:
-入力データタイプに合わせて特に調整されていない、一般
的なパラメータ設定です。

• VHR (better than 3m) :
- ALOS-2 の高分解能モード(3m)で干渉 SAR を行う場合や、
市街地などコヒーレンスが良い場所といった場合の超高解
像度データに適しています。

• Interferometry Low Coherence:
-山間部や事前に大きな変動が発生していることが分かって
いるケースなど、コヒーレンスが良くないと想定される場
所での設定に適しています。

• Sentinel TOPSAR (IW – EW):
- TOPSAR(IW)モードで取得した Sentinel データ(※日本国内は
これに該当)の干渉処理を実施する場合、この設定は必須で
す
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ENVIの基本操作について
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SARscape入門

ファイル読み込み

• ENVI にALOS PALSAR のSLC画像を読み込んで表示します。ラスタデー
タの読み込み、表示を行います。

• SARscapeを用いてインポート済みのSLCデータです。このデータは
ENVI形式のデータです。

22

C:¥training¥SARscape¥PALSAR¥SLC¥
20091204_slc



SARscape入門

20091204_slcについて

読み込んで表示しているデータは、
SLC（Single Look Complex）デー
タです。

•データのタイプは複素数（実数、
虚数）となります。

• ENVIでは、内部的にMagnitude
（実数と虚数の二乗の和の平方
根にしたもの）を計算した画像
を表示しています。
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SARscape入門

ENVI形式とは

ENVI フォーマット(ENVI から作成されるファイル)は、単純なラスタフォーマットのデータです。

• このフォーマットはバイト型で形成され、フラットバイナリファイルと呼ばれるデータフォー
マットです。

• このフォーマットは画像以外のデータが含まれないため、ENVI はENVI ヘッダファイル（ENVI 
Header File：*.hdr ）というASCII ファイルを作成し、そこに画像を読み込むためのパラメータ情報
を記録します。

24

• 拡張子なしまたは.dat形式のフラットバイナリデータ
• .hdr形式の関連情報を書き込んだASCIIファイル

【ENVIフォーマットの構成要素】

フラットバイナリデータ

ASCII ファイル



SARscape入門

SARscapeのファイルフォーマットとは

• SARscapeのファイルフォーマットは、データをSARscapeへインポート後に
作成されます。
-画像についてはENVIフォーマットと同等になります。

• SARの解析を行うため、通常のENVIフォーマットに軌道情報等のSARの処理
に必要なパラメータが含まれたSMLファイルが付加されています。

• SARscapeでSARの解析処理を行うためには、以下の3つのファイルが必要と
なります。
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ファイルの種類 内容

画像データ フラットバイナリの画像データ

ENVIヘッダーファイル ENVIがファイルを読み込む際に必要とするヘッダーファ
イル（ASCII形式）

SARscape
パラメータファイル

SARscapeが処理の際に使用するパラメータファイル
（XML形式）

【例】



SARscape入門

View Metadata

• データが開かれたら、レイヤ
マネージャで右クリックし
View Metadataを選択して詳
細を確認してみます。

• データのサイズや型に加え、
設定されていれば、投影情報
や波長情報が確認できます。
-現在読み込まれているデータ
が、実数（浮動小数点）、符
号付もしくは符合無しの整数
型かどうかを理解することは、
データ解析をする上で重要に
なります。

-今回のデータはComplex(複素
数)で定義されていることが確
認できます。
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SARscape入門

ディスプレイツール

ツールバーで提供されているツールを使用して、表示した画像に様々な
操作を行うことができます。

• Cursor Value
-十字が交差するポイントのピクセル値や緯度経度を確認できる

• Arbitrary Profile
-始点と終点を指定すると、その間のピクセル分布を確認できる
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https://www.nv5geospatialsoftware.com/docs/DisplayTools.html

演習:
Cursor Valueツールを使用して、開いたSLCデータのピクセル
値を確認してみます。このデータには地理情報が登録され
ていないため、地点の緯度経度ではなく画像のピクセル座
標が表示されることを確認します。

https://www.nv5geospatialsoftware.com/docs/DisplayTools.html


SARscape入門

3ボタン式マウスによる移動の簡略化: 
パン機能とズーム機能について

28

クリック

前後回転



SARscape入門

ストレッチの調整

•表示した画像に対して、ストレッチやコントラストなどを変更して、
画像を見やすくします。

•レイヤマネージャで表示されている画像を選択し、操作を行います。

29



SARscape入門

ストレッチとは？
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各ピクセルの値分布を調整して
見やすくするための処理

暗く見える 明るく見える

各ピクセルには様々な値が入っており、上に示すような分布だとします。
（値の取る範囲は、データがどのような型を持つかに依ります。詳細は後述します。）

最大値最小値



SARscape入門

ストレッチとは？
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各ピクセルの値分布を調整して
見やすくするための処理

暗く見える 明るく見える

まずはENVIで表示するにあたって、データ値を輝度値(0から255のBYTE値)に変換します



SARscape入門

ストレッチとは？
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各ピクセルの値分布を調整して
見やすくするための処理

暗く見える 明るく見える

全体的に暗いので、
この辺りで見え方を
調整し直したい



SARscape入門

ストレッチとは？
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各ピクセルの値分布を調整して
見やすくするための処理

暗く見える 明るく見える

この辺りで見え方を
調整し直したい
この範囲で明るさを
再度調整した



SARscape入門

ストレッチとは？

34

各ピクセルの値分布を調整して
見やすくするための処理

暗く見える 明るく見える

この辺りで見え方を
調整し直したい



SARscape入門

ストレッチとは？
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各ピクセルの値分布を調整して
見やすくするための処理

暗く見える 明るく見える

この辺りで見え方を
調整し直したい



SARscape入門

ストレッチの実施

ENVIのストレッチ機能には、変換方法が幾つか用意されています
• ここではLinear 2%からSquare Rootに変更します
• その他のストレッチ手法について:

- https://www.nv5geospatialsoftware.com/docs/BackgroundStretchTypes.html

36
Linear 2% Square Root

https://www.nv5geospatialsoftware.com/docs/BackgroundStretchTypes.html


SARscape入門

ストレッチの実施（Viewエリアで最適化）

1.  ボタンで全体を表示し、     
ボタンで水域(暗い箇所)

を拡大します

2.      ボタンで、表示したエ
リアについてストレッチを
適用します

3.  ボタンをクリックして
拡大/縮小による自動更新
を有効に設定します

4.      ボタンで、全体に対し
て再度ストレッチを実施し
ます

37

Stretch on View Extent



SARscape入門

カラーの変更

前の項目で表示したレーダ画像に対して疑似カラーを付与します。

•グレイスケールの画像には、カラーテーブルを割り当てることで、
データの分布を一目で確認することが可能です。

•疑似カラーを付与する機能として、「Change Color Table」と「Raster 
Color Slices」のツールがあります。
-この演習では、Change Color Tableについてのみ触れます。
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Raster Color Slicesについては以下を参照: 
https://www.harrisgeospatial.com/docs/ColorSlices.html

https://www.harrisgeospatial.com/docs/ColorSlices.html


SARscape入門

Change Color Table

1. レイヤーマネージャ → グレ
イスケール画像の
「20091204_slc」を右ク
リック → Change Color Table 
→Rainbow を選択します。

2. カラーテーブルを選択すると、
選択したカラーテーブルによ
り色づけされた画像がディス
プレイに表示されます。

適用している疑似カラーは、
データの実際の各ピクセル値に
対してではなく、ストレッチさ
れた後の見え方に対して適用さ
れています。

• ストレッチを変更すると、色の
当たり方が変わることを確認し
てください
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SARscape入門

データマネージャ

Data Manager は読み込んだファイルを管理しています。

• レイヤーマネージャでは、表示している画像の情報しか表示されません。

• データの詳細情報を確認する時や、すでに読み込んだデータを別の表現(バンドのグレイスケール
表示や、RGB コンポジットの変更など)で表示する際にこのマネージャを使用します。

• https://www.nv5geospatialsoftware.com/docs/OpeningLocalFiles.html#OpenDataManager

40

OPEN

Data Manager Layer Manager
ENVI View

https://www.nv5geospatialsoftware.com/docs/OpeningLocalFiles.html#OpenDataManager


SARscape入門

データマネージャ: 演習

1. メニュー → File → Data 
Manager を選択してくださ
い。

2. Data Manager ダイアログ 
→ 「20091204_slc」の
[Real]を右クリック → 
Load Grayscale を選択して
ください。

3. Real が表示され、レイ
ヤーマネージャへ追加され
ていることを確認してくだ
さい。

41



SARscape入門

画像を閉じる

•表示している画像を閉じ、必要がなく
なったView を閉じることが出来ます。
-個々のレイヤはレイヤを右クリックし、

Removeで閉じます

-Viewを削除する場合はViewを右クリック
し、Remove Viewを選択します

-Viewは残したまま、Viewにあるレイヤを
削除するには Remove All Layersを選択し
ます。

42

✓ Layer Managerから削除してもData Managerにはデータが残ります。
✓ 必要のないファイルを閉じる場合は、Data Manager から該当ファイ

ルを右クリック → Close File を選択してください。



SARscapeでの基本処理（Basic Module）
データのインポートと切り出し編

43



SARscape入門

SARscapeでの基本処理（事前準備）

ワークフロー内にもインポートや切り出しの機
能はありますが、基本となるステップのため、
それぞれの機能について説明します。

•データのインポート

•解析範囲の切り出し

44



SARscape入門

データのインポート: 演習

• データ配布元から提供されたデータは、一度
SARscapeのインポート機能にてENVIフォー
マット＋SMLファイルの形式に変換する必要
があります。

• SARscapeでは、これまでに衛星に搭載されて
いるSARデータに関しては、ほとんどのデー
タをサポートしています。Basic モジュール
を利用してSAR画像を扱う上で必ず必要にな
るデータ処理方法について説明します。

1. ENVIツールボックス→ SARscape → Import 
Data → SAR Spaceborne  → Single Sensor → 
ALOS PALSAR-1 を選択してください。

45



SARscape入門

データのインポート: 演習

2. Import ALOS PALSAR-1ダイアログが表示
されます。Input File List → Browse 
Files…ボタン をクリックしてCEOSの
イメージファイル「IMG-HH-
ALPSRP205672900-H1.1__D」を選択し
ます。

46

【設定値】
C:¥Training¥SARscape¥PALSAR¥Original¥l1data¥
IMG-HH-ALPSRP205672900-H1.1__D



SARscape入門

データのインポート: 演習

3. 今回のデータは、JAXAフォーマットの
PALSAR FBS L1.1 のデータです。
Parametersタブ → Data Type および
Rename the File Using Parameters を変
更します。

47

【設定値】
Data Type: JAXA – FBS Level1.1
Rename the File Using Parameters: false



SARscape入門

データのインポート: 演習

4. Output Filesタブにて出力ファイル名を入力します。Output File List 
→ ファイル名を右クリックしてEdit → 「palsar_fbs_full」へと変更
しチェックマークで確定 → ツール下部の「Exec」をクリックして
ツールを実行してください。

48

処理が正常に完了すると、Completedという
メッセージダイアログが出現します。
OKボタンを押下しても、
ツール自体は自動では閉じられません。
もう一度Execを押下しないようご注意ください。



SARscape入門

データのインポート: 演習

5. インポートしたデータは自動的にENVI
へ表示されます。
✓ファイル名には、SLCであることを示す_slc
が自動的に付加されています

6. KMLファイル（Google Earth 形式のファ
イル）も作成されますので、地理的な
位置を簡単に確認することが可能です。

49

補足:
メニュー → File → Open As → Radar からもさまざまなSARデータをインポートすることが可能ですが、
このようにしてメニューから読み込まれたものは、SARscapeツールのインプットデータに使用し処
理を行うことはできません。（あくまで表示のみ）
SARデータを干渉といった「処理」のインプットに利用するためには、ここで紹介したような
SARscapeツールによるインポートの工程が必要となります。



SARscape入門

ENVIのレンジ・アジマス設定
(※右側照射を前提とした説明)

【仕様】

ENVIは左上を原点とします

• X軸方向がレンジ

• Y軸方向がアジマス

衛星の軌道は2通り

• アセンディング軌道
-南から北に向かう軌道

• ディセンディング軌道
-北から南に向かう軌道

50

どちらの起動で取得されたかにより、
ENVIで読み込んだ際の表示のされ方が異なります。
※ジオコーディング前



SARscape入門

ENVIで読み込んだ際の表示:
アセンディング軌道の場合

アセンディング軌道は上下反転して表示されます
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SARscape入門

ENVIで読み込んだ際の表示:
ディセンディング軌道の場合

ディセンディング軌道は左右反転して表示されます
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SARscape入門

レンジ方向とアジマス方向で分解能が異なると、
画像が伸びたように表示される

53

10mを５ピクセルに分割

10

m
を
10
ピ
ク
セ
ル
に
分
割

表示する時は
各ピクセルは正方形

データを多くとれる（解像度の細かい）
アジマス側に伸びている

補足 : 必ずしも縦長とは限らない
• ENVISATは横長
• TerraSARはほぼ1:1

例: 
ある衛星では、レンジ方向で2m解像度、アジマス方向で1m解像度とします。
この状態で10m四方を見ると、レンジ方向で5ピクセル、
アジマス方向で10ピクセル分データが取得できることになります。



SARscape入門

解析範囲の切り出し: 演習

• SARデータのSLC（Single Look Complex）はファイ
ルサイズが大きいため、フルシーンでは処理時間
がかかってしまうことがあります。その際は、事
前に画像切り出しを施すことが有効ですが、
SARscapeで切り出し画像を処理する際にもsml
ファイルが不可欠になります。

• ENVIや他のソフトウェアで切り出しを実施した
ファイルでは、smlファイルが付属しておらず
SARscapeでは処理できませんので、SARscapeの
Sample Selectionツールを使用して実施します。

1. ENVIツールボックス→ SARscape → General 
Tools → Sample Selections  → Sample Selection 
SAR Geometry Dataを選択してください。
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SARscape入門

解析範囲の切り出し: 演習

2. Input Filesタブで入力ファイルを指定し
ます。Input File List →Browse Filesボタ
ン →「palsar_fbs_full_slc」を指定しま
す。

55

【設定値】
C:¥Training¥SARscape¥Output¥

<先ほど出力したファイル>



SARscape入門

解析範囲の切り出し: 演習

3. Optional Filesタブを選択し、Area of 
Interestに切り出し範囲を指定した
シェープファイルを指定します。

56

【設定値】
C:¥training¥SARscape¥PALSAR¥Shape¥
subsetArea.shp

✓ Sample Selectionで使用できるシェープファイルは緯度経度
座標(Lat/Lon)で定義されている必要があります。

✓ UTMで定義されたシェープファイルでは切り出せないので
注意が必要です。

注意点



SARscape入門

解析範囲の切り出し: 演習

4. ParametersタブのGeographic RegionをTrueに設定します。各
Column/Rowの値は設定したシェープファイルから読み込まれるので
-9999のままで構いません。

5. Output Filesタブで出力ファイルを指定します。Output File List → 
「palsar_fbs_full_cut_slc」になっていることを確認し「Exec」をク
リック(切り出しを示すため、自動で付加されます)
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SARscape入門

解析範囲の切り出し: 演習

結果が表示されることを確認します。

→ なぜ斜めに切り出されたのか？

58

出力結果使用したシェープファイルのエリア



SARscape入門

解析範囲の切り出し: 解説

• 切り出しに使用したシェープファイルが長方
形のポリゴンだとしても、頂点に対応する緯
度経度はSARイメージの上では必ずしも長方
形にはなりません
-ジオコーディングという処理を実施した後に得ら
れるイメージは、切り出しに使用したシェープ
ファイルと同じような長方形のものになります。

59



SARscapeでの基本処理（Basic Module）
Sentinel-1を使用した災害の前後比較
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SARscape入門

処理の概要とデータについて

インポート/サブセット済みのSentinel-1の
SLCデータ2シーンに対して以下の処理を行
い、前後比較を行います

1. 強度画像の作成(Multilooking)

2. 作成した強度画像の位置合わせ
(Coregistration)

3. 地図情報の付加(Geocoding and 

Radiometric Calibration)

4. RGB合成を変更することにより被害エリ
アを強調
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SARscape入門

使用するデータについて

関東地方における令和元年の台風19号
襲来前後

• 撮影時期: 2019年8月19日 / 2019年10
月12日のペア(襲来は10月12日夜間)
✓S1B_IW_SLC__1SDV_20191012T204247_2

0191012T204314_018447_022C0C_0256

✓S1A_IW_SLC__1SDV_20190819T204321_
20190819T204349_028643_033DB5_08
2A

• パラメータ設定はENVI ツールボックス 
→ SARscape → Preferences → 
Preferences specific → Sentinel TOPSAR
を使用
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出展: 東京消防庁
(https://www.tfd.metro.tokyo.lg.jp/camp/2020/202005/camp1.html)
令和元年東日本台風に伴う増水した荒川
（国土交通省荒川下流河川事務所より引用）

https://www.tfd.metro.tokyo.lg.jp/camp/2020/202005/camp1.html


SARscape入門

Preferences specificの変更

• Sentinel-1のTOPSAR(IW)を使用した解析を
行う場合ので、Sentinel TOPSAR (IW - EW)と
いう設定に変更してください。
- /SARscape/Preferences/Preferences specific
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SARscape入門

Sentinel-1のインポート結果について

• Sentinel-1は、広域を TOPSAR というモードで観測を行うため、ファイ
ルがバーストという単位で構成されます。
-3つのサブスワスの中に 約9個ずつのバーストが含まれており、SARscape にお
いて、ユーザはこれらのファイル構成を意識することなく操作できます。
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https://sentinel.esa.int/web/sentinel/user-guides/sentinel-1-
sar/acquisition-modes/interferometric-wide-swath

https://sentinel.esa.int/web/sentinel/user-guides/sentinel-1-sar/acquisition-modes/interferometric-wide-swath
https://sentinel.esa.int/web/sentinel/user-guides/sentinel-1-sar/acquisition-modes/interferometric-wide-swath


SARscape入門

Sentinel-1のインポート結果について

• Sentinel-1は、広域を TOPSAR というモードで観測を行うため、ファイ
ルがバーストという単位で構成されます。
-「*_slc_list」というファイルにおいてバーストが内部的に管理されています。
各バーストのファイルは、出力に指定したサブフォルダ内に保存されています。
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各バーストの実体となる_slcは
このフォルダ *_bursts 中で管理

バーストの構成管理は
*_slc_listで定義



SARscape入門

Sentinel-1のインポート結果の切り出しについて

• Sample SelectionでSentinel-1のデータを切り出す際には、*_slc_listを
インプットに指定する
-出力結果は*_cut_slc_listで構成管理され、実体となる_slcは*.split_burst_cut
フォルダ配下に配置される
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各バーストの実体となる_slcは
このフォルダ *_bursts_cut 中で管理

バーストの構成管理は
*_cut_slc_listで定義



SARscape入門

Multilooking

マルチルック処理を実施する目的は次の3つです。
✓強度画像を作成するため

✓SAR画像に含まれたノイズを軽減するため

✓(補助的) 縦横をサイズを正方形に近づけ、地物の判読をしやすくするため
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SARscape入門

Multilooking

マルチルック処理を実施する目的は次の3つです。
✓強度画像を作成するため

✓SAR画像に含まれたノイズを軽減するため

✓(補助的) 縦横をサイズを正方形に近づけ、地物の判読をしやすくするため
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SARscape入門

Multilooking

マルチルック処理を実施する目的は次の3つです。
✓強度画像を作成するため

✓SAR画像に含まれたノイズを軽減するため

✓(補助的) 縦横をサイズを正方形に近づけ、地物の判読をしやすくするため
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SARscape入門

Multilooking

マルチルック処理を実施する目的は次の3つです。
✓強度画像を作成するため

✓SAR画像に含まれたノイズを軽減するため

✓(補助的) 縦横をサイズを正方形に近づけ、地物の判読をしやすくするため
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SARscape入門

Multilooking

マルチルック処理を実施する目的は次の3つです。
✓強度画像を作成するため

✓SAR画像に含まれたノイズを軽減するため

✓(補助的) 縦横をサイズを正方形に近づけ、地物の判読をしやすくするため
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SARscape入門

Multilooking

マルチルック処理を実施する目的は次の3つです。
✓強度画像を作成するため

✓SAR画像に含まれたノイズを軽減するため

✓(補助的) 縦横をサイズを正方形に近づけ、地物の判読をしやすくするため
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SARscape入門

Multilooking

マルチルック処理を実施する目的は次の3つです。
✓強度画像を作成するため

✓SAR画像に含まれたノイズを軽減するため

✓(補助的) 縦横をサイズを正方形に近づけ、地物の判読をしやすくするため
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SARscape入門

Multilooking

1. /SARscape/Basic/Intensity 
Processing/Multilookingを起動します

2. 以下の設定を行い、Execを押下します
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【Input Files】
C:¥training¥SARscape¥Sentinel
✓ sentinel1_46_20191012_204249184_IW_

D_VV_cut_slc_list
✓ sentinel1_46_20190819_204323662_IW_

D_VV_cut_slc_list

【Parameters】
デフォルトの設定とします

【Output Files】
C:¥training¥SARscape¥Outputに出力される
ことを確認する



SARscape入門

Multilooking

•強度画像が表示されることを確認します
-この時点では地図情報は設定されていません
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Multilookされたデータ 対応するエリア

※斜め方向に切り出されているのは、Sample Selectionのスライドで説明したものと同様の理由です



SARscape入門

Coregistraion

•コレジストレーション処理では、スラント
レンジ画像のまま画像のマッチングを行う
ことが可能です。 

•コレジストレーション処理を行うためには、
各シーンは軌道と撮影モードが同じである
必要があります。

• DEMを参考情報として設定することもでき
ます。
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SARscape入門

Coregistraion

1. /SARscape/Basic/Intensity 
Processing/Coregistrationを起動します

2. 以下の設定を行い、Execを押下します
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【Input File list】
C:¥training¥SARscape¥Output
sentinel1_46_20191012_204249184_IW_D_
VV_cut_slc_pwr
sentinel1_46_20190819_204323662_IW_D_
VV_cut_slc_pwr

【Parameters】
デフォルトの設定とします

【Output Files】
C:¥training¥SARscape¥Outputに出力される
ことを確認する



SARscape入門

Geocoding and Radiometric Calibration

• SAR画像では地上からのレーダ反
射を斜め上空から測定しているた
め、高い地物などでは、光学画像
よりも大きなゆがみが発生します。

• SARscapeではこのゆがみを補正
するため、DEMを使用してジオ
コーディング処理を行います。

• DEMを使用し、フォーショートニ
ング、レイオーバーといったSAR
特有のゆがみも補正することが可
能です。
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衛星側に倒れ込むように見える



SARscape入門

Geocoding and Radiometric Calibration

1. /SARscape/Basic/Intensity 
Processing/Geocoding/Geocoding and 
Radiometric Calibrationを起動します

2. 以下の設定を行い、Execを押下します
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【Input Files : 先ほどの出力結果】
C:¥training¥SARscape¥Output¥
sentinel1_46_20191012_204249184_IW_D_VV_c
ut_slc_pwr_rsp
sentinel1_46_20190819_204323662_IW_D_VV_c
ut_slc_pwr_rsp

【DEM/Cartographic System】
C:¥training¥SARscape¥Sentinel¥DEM
- Srtm-3_V4_dem

【Output Files】
C:¥training¥SARscape¥Outputに出力されること
を確認する



SARscape入門

補足: Grid Size

• マルチルックを実行するときのGrid Sizeと、ジオコーディングする際のGrid Sizeは
区別して考える必要があります
-マルチルックで指定するGrid Sizeは、元々のレンジ/アジマス方向の解像度から1ピクセルの縦
横サイズの目安を決めています

-ジオコーディングで指定するGrid Sizeは、出力されるデータの1ピクセルを何m解像度と定義
するかを決めています
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レンジ解像度7m、
アジマス解像度3mとすると、
グリッドサイズ15mなら
レンジ2つとアジマス5つで
マルチルックする

7m 7m

3m

3m

マルチルック後



SARscape入門

補足: Grid Size

• マルチルックを実行するときのGrid Sizeと、ジオコーディングする際のGrid Sizeは
区別して考える必要があります
-マルチルックで指定するGrid Sizeは、元々のレンジ/アジマス方向の解像度から1ピクセルの縦
横サイズの目安を決めています

-ジオコーディングで指定するGrid Sizeは、出力されるデータの1ピクセルを何m解像度と定義
するかを決めています
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マルチルックでグリッドサイ
ズ15mとしていても、
ジオコーディングした後の
1ピクセル解像度は
自由に定義できる

15m 15m

15m

15m

① ②

③ ④

① ① ①

① ① ①

① ① ①

5m 5m 5m

② ② ②

② ② ②

② ② ②

③ ③ ③

③ ③ ③

③ ③ ③

④ ④ ④

④ ④ ④

④ ④ ④

マルチルック後

ジオコーディングで
定義したのが5mグリッドなら
右図のようになる

※ジオコーディングの過程でリ
サンプリングの影響を受けるた
め、対応する座標のピクセル値
が必ずしも元と同じ値にはなる
とは限らない



SARscape入門

補足: Grid Size

• マルチルックを実行するときのGrid Sizeと、ジオコーディングする際のGrid Sizeは
区別して考える必要があります
-マルチルックで指定するGrid Sizeは、元々のレンジ/アジマス方向の解像度から1ピクセルの縦
横サイズの目安を決めています

-ジオコーディングで指定するGrid Sizeは、出力されるデータの1ピクセルを何m解像度と定義
するかを決めています
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マルチルックでグリッドサイ
ズ15mとしていても、
ジオコーディングした後の
1ピクセル解像度は
自由に定義できる

15m 15m

15m

15m

① ②

③ ④

30m 30m

①から④を参考に計算された値

ジオコーディングで
定義したのが30mグリッドなら
右図のようになる

マルチルック後

※ジオコーディングの過程でリ
サンプリングの影響を受けるた
め、対応する座標のピクセル値
が必ずしも元と同じ値にはなる
とは限らない



SARscape入門

Geocoding and Radiometric Calibration

3. ENVIレイヤマネージャに以下のファ
イルが追加されていることを確認し
ます
sentinel1_46_20191012_204249184_IW_D
_VV_cut_slc_pwr_geo_meta

4. データマネージャーを起動します

5. 以下のRGB構成でロードします
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:台風通過前(8/19)
:台風通過後(10/12)
:台風通過後(10/12)



SARscape入門

結果の確認
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SARscape入門

結果の確認
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国土地理院:令和元年東日本台風に関する情報
https://www.gsi.go.jp/BOUSAI/R1.taihuu19gou.html

https://www.gsi.go.jp/BOUSAI/R1.taihuu19gou.html


SARscape入門

参考: 
Intensity Time Series による植生の時系列変化

複数の強度画像から特徴的なエリアを
抽出・強調するためのワークフローが
提供されています。
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SARscape入門

参考: 
Intensity Time Series による植生の時系列変化

複数の強度画像から特徴的なエリアを
抽出・強調するためのワークフローが
提供されています。
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変動係数(Coefficient of 
Variation)

最小値(Min)

勾配(Gradient)



SARscape入門

SARscapeでの基本処理についての補足: 
DEMダウンロードツール

• SARscapeでは、STRM3 version 4といったDEMをダウンロードするた
めのツールが提供されています。
-ENVIツールボックス → SARscape → General Tools→ DEM Extraction → 使用す
るDEMを選択

-DEMのインプットが必要な処理では、DEM/Cartographic Systemタブの
Download DEMボタン から個別ツールが起動できます。
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SARscape入門

SARscapeでの基本処理についての補足: 
DEMダウンロードツール

• SARscapeでは、STRM3 version 4
といったDEMをダウンロードす
るためのツールが提供されてい
ます。
-ワークフロー機能の場合、

DEM/Cartographic Systemタブの
DEM Downloadを選択すると、一連
の処理のなかでDEMのダウンロー
ドが行われます。
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SARscape入門

SARscapeでの基本処理についての補足: 
DEMインポート

• SARscapeのDEM Extractionツールでサポートされ
ていないDEMデータを使用する場合は、以下のよ
うなステップが必要です。

1. SARscapeへのインポート処理
2. 標高から楕円体高への変換処理

インポート処理（GeoTIFF形式の場合）

1. ENVIツールボックス → SARscape → Import Data 
→ Generic Format → Tiffから手元のDEMデータ
に合ったフォーマットのインポータを選択して
ください。

2. データを読み込む際に、Parametersタブ → 
Principal Parameters → Data unitをGeoidal DEM
に設定してください。Dummy Valueには、入力
ファイルの無効値を入力してください。

90



SARscape入門

SARscapeでの基本処理についての補足: 
DEMインポート

楕円体高への変換

1. ENVIツールボックス → SARscape → General Tools → 
Cartographic Transformation → Geoid Component

2. Parametersタブ → Principal Parameters → Geoid 
Operation → Subtract Geoidに設定し、Geoid Typeを
選択してください。
✓ジオイド高の影響を「取り除く(Substract)」という意味の
設定で、内部計算上は標高(データのピクセル値)に対しジ
オイド高が加算されている

3. Output Filesタブで設定する出力ファイルでは、
「ファイル名_dem」となるように命名してください。
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楕円体高、ジオイド高、標高の関係
出展: 国土地理院

https://www.gsi.go.jp/buturisokuchi/grageo_geoid.html

https://www.gsi.go.jp/buturisokuchi/grageo_geoid.html


SARscapeインターフェロメトリ
（Interferometry Module）
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SARscape入門

SARインターフェロメトリ(干渉SAR)とは:
ヤングの干渉実験

•光波と光波がぶつかって、強め合った箇所は明るくなり、弱め合った
箇所は暗くなります。スクリーン上にはそれらが交互に現れ、干渉縞
という縞模様ができます。(高校物理 // 光と波のはなし)

• SAR衛星もマイクロ波を照射しているので、2シーンを干渉処理させる
と縞模様ができます。干渉SARはこれと同じ原理です。
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SARscape入門

SARインターフェロメトリ(干渉SAR)とは: 
干渉処理を行う際の前提条件

• 処理で必須になるのは「 2つのSARデータ」と「 1つのDEMデータ」です。

• これらのデータは観測条件がすべて一致している必要があります。
-同じ衛星で取得したデータであること
-同じ軌道で取得したデータであること
-同じ観測モードで取得したデータであること
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撮影された場所が微妙に違うので、
干渉処理を行うと干渉縞ができる

進行方向

出展 : 

日本リモートセンシング学会「基礎からわかるリモートセンシング」(理工図書株式会社) 

講義用パワーポイント 第１５章 SARの高度解析 

視線方向



SARscape入門

SARインターフェロメトリ(干渉SAR)とは:
この干渉縞は何でできている？

干渉処理の最初にできるこの干渉縞を、初期干渉縞とよびます。

95

【初期干渉縞の構成要素】
1. 衛星の軌道が微妙にずれているために起きる干渉縞（軌道縞）
2. 地形の起伏で起きる干渉縞（地形縞）
3. 撮影する前後で地面に変動があったことで起きる干渉縞（変動縞）

初期干渉縞からこれらの情報を除いていき、
目的の情報を得るのが干渉処理の流れになります 出展 : 

日本リモートセンシング学会「基礎からわかるリモートセンシング」(理工図書株式会社) 

講義用パワーポイント 第１５章 SARの高度解析 



SARscape入門

SARインターフェロメトリ(干渉SAR)とは:
処理の流れ

• 2つの複素数データから位置合わせして初期干渉縞をつくります。

• 2つの軌道情報からシミュレートした軌道縞をつくります。

• 初期干渉縞からシミュレートした軌道縞を取り除き、干渉縞をつくります。

96

進行方向

視線方向

初期干渉縞

シミュレートした軌道縞

干渉縞

進行方向

視線方向出展 : 

日本リモートセンシング学会
「基礎からわかるリモートセンシング」(理工図書株式会社) 

講義用パワーポイント 第１５章 SARの高度解析 

進行方向

視線方向
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SARインターフェロメトリ(干渉SAR)とは:
処理の流れ
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【初期干渉縞の構成要素】→【干渉縞の構成要素】
1. 衛星の軌道が微妙にずれているために起きる干渉縞（軌道縞）
2. 地形の起伏で起きる干渉縞（地形縞）
3. 撮影する前後で地面に変動があったことで起きる干渉縞（変動縞）

この干渉縞を2通りに解釈する

干渉縞

進行方向

視線方向

InSAR

解釈1: 地面の変動は発生していない
この場合、変動縞の成分は存在しない。
つまり干渉縞=地形縞なので、これを高さに変換すれば
地表面の高さ情報(DEM)を取得することができる

DInSAR

解釈2: 地面が撮影の前後で変動している
この場合、変動縞の成分も存在していると考える。
このうち地形縞の成分は参考となるDEMからシミュレートできるので、
地表面の変動情報を取得することができる

除去



DInSAR Displacement ワークフロー
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処理の概要

SAR画像ペアからインターフェログラム（干渉画
像）を作成し、変動マップ作成まで一連の処理を
実行します。

1. インターフェログラムの作成

2. コヒーレンス画像作成と干渉フィルタ

3. 位相のアンラップ処理

4. 軌道補正と位相のオフセット計算

5. 変動マップの作成

99
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使用するデータについて

Bam地方のENVISAT ASAR IS2地震前後

•撮影時期: 2003年12月3日 / 2004年2月11日のペア

•本トレーニング使用するデータはすでにSARscapeへインポート済み

100

テヘランタイムズ: 
https://www.tehrantimes.com/news/419753/On-the-

occasion-of-2003-Bam-earthquake

バム地震(2003 Bam earthquake) 
• 2003年12月26日午前5時28分発生
• 震央はイラン南東部のケルマーン州バム
• マグニチュード6.6の直下型地震

https://www.tehrantimes.com/news/419753/On-the-occasion-of-2003-Bam-earthquake
https://www.tehrantimes.com/news/419753/On-the-occasion-of-2003-Bam-earthquake


SARscape入門

Preferences specificの変更

•先ほどの演習でSentinel TOPSAR (IW - EW)を
使用していたので、ここではGeneralとい
う設定に変更してください。
- /SARscape/Preferences/Preferences specific

101



SARscape入門

まず干渉するデータペアかを確認

• Baseline Estimation: Normal Baseline / Critical Baseline
- ENVI ツールボックス → SARscape → Interferometry → Interferometric Tools → Baseline Estimation

• 選んだSAR画像のペアは、干渉処理ができるかを調べるツールです。
- 注）得られた結果は参考値であり、処理の中で使用されるものではありません。
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垂直ベースライン距離（Normal Baseline）が、
干渉処理に適した理論値(Critical Baseline)の範囲
に収まるかどうかを確認してください。



SARscape入門

Baseline Estimationの確認

1. ENVI ツールボックス → SARscape → Interferometry → Interferometric 
Tools → Baseline Estimationを選択し、設定ダイアログを起動します。

2. Input FilesタブにReferenceおよびSecondaryのファイルを設定し、
Execボタンで実行します。
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【設定値】
Input Fileタブ
Input Reference File: 

C:¥Training¥SARscape¥DInSAR¥3dec03_slc
Input Secondary File:

C:¥Training¥SARscape¥DInSAR¥11feb04_slc
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Baseline Estimationの確認

出力結果を確認します。
⚫Normal Baseline（垂直方向の距離）がCritical Baseline（臨界ベースライ
ン）の距離に収まっているか確認します。
⚫Critical BaselineよりNormal Baselineが大きくなった場合は、位相情報が大
きく異なるため、二つの画像を干渉させ、インターフェロメトリの処理を
行うことができません。
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干渉するための臨界ベースラインが
±966.296[m]に対し、両者のノーマル
ベースラインが3.773[m]であるので、
このペアは干渉できるペアとわかる。



SARscape入門

Baseline Estimation:
2 PI Ambiguity displacement (DInSAR) (m) 

105

干渉縞1波長(2πサイクル)に対応する変位を表します。
• この数値が大きいほど、小さな変位の変化を検出する能力が粗くなります。
• これは使用している衛星の波長に依存し、衛星間の距離は影響しません。

𝜓2𝜋 =
𝜆

2

演習で使用しているENVISATの波長はおよそ 5.6cm なので……

→ このSAR画像ペアでは、1波長に対しておよそ0.028mの変動感度があると分かる

𝜓2𝜋 =
𝜆

2
=
5.6 × 10−2

2
= 0.028[𝑚]
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Baseline Estimation:
2 PI Ambiguity height (InSAR) (m)

106

干渉縞1波長(2πサイクル)に対応する高さを表します。
• この数値が大きいほど、小さな高さの変化を検出する能力が粗くなります。
• 衛星間の距離が離れているほど高さ方向の検出精度は高くなります。

演習で使用しているENVISATの波長はおよそ 5.6cm なので……

→ このSAR画像ペアでは、1波長に対しておよそ2521mの高さ感度があると分かる

𝜙 =
4𝜋𝐵𝑛

𝜆𝑅𝑠𝑖𝑛(𝜃)
ℎ

𝜙=2𝜋
ℎ2𝜋 =

𝜆𝑅𝑠𝑖𝑛 𝜃

2𝐵𝑛

𝐵𝑛: 垂直ベースライン距離
𝜆: 観測衛星の波長
𝑅: スラントレンジ距離
𝜃: Referenceの入射角

ℎ2𝜋 =
𝜆𝑅𝑠𝑖𝑛 𝜃

2𝐵𝑛
=
5.6 × 10−2 × 849807.494 × sin(23.457 𝑑𝑒𝑔)

2 × 3.773
≈ 2521[𝑚]
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2 PI Ambiguity height (InSAR) (m)の値と
InSAR処理の向き不向きについて
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𝜙 =
4𝜋𝐵𝑛

𝜆𝑅𝑠𝑖𝑛(𝜃)
ℎ

𝜙=2𝜋
ℎ2𝜋 =

𝜆𝑅𝑠𝑖𝑛 𝜃

2𝐵𝑛

𝐵𝑛: 垂直ベースライン距離
𝜆: 観測衛星の波長
𝑅: スラントレンジ距離
𝜃: Referenceの入射角

ベースラインが長い 2πAHが小さい
→ 小さな高さの変化を検出する能力が高い

InSARに向いたペア

ベースラインが短い 2πAHが大きい
→ 小さな高さの変化を検出する能力が低い

InSARに向いていないペア

※大きい/小さいの目安: 100[m]前後

参考: 
ALOS-2やSentinel-1のような衛星は軌道毎の衛星間距離が一定の範囲内に収まるよう制御されています。
一般にペア間のベースラインが短い(= 2 PI Ambiguity heightが大きい)ため、DEM作成を目的としたInSAR処理には不向きです。
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DInSAR Displacementワークフロー: 演習
Input ステップ

1. ENVI ツールボックス → SARscape → Interferometry 
→ DInSAR Displacement Workflowを選択し、DInSAR
ワークフローダイアログを起動してください。
✓ツールボックスの検索機能は使用しないでください。先に
検出されたツール名のものが優先表示され、GCP取得の工
程が省略された方のDInSAR Displacement Workflowが起動さ
れてしまいます。

2. Inputダイアログの設定は以下のようになります。以
下の値を設定し、Nextボタンをクリックしてくださ
い。

108

Input Fileタブ
Reference File:  C:¥Training¥SARscape¥DInSAR¥3dec03_slc
Secondary File: C:¥Training¥SARscape¥DInSAR¥11feb04_slc

DEM/Cartographic Systemタブ
DEM file: C:¥Training¥SARscape¥DInSAR¥srtm25_dem

Parametersタブ:
GridSize: 25.0

Next>>>は押さないでください。
対話的な処理が必要な工程まで、要求されるまで処
理が一気に進んでしまいます。
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DInSAR Displacementワークフロー: 演習
Import Generic SAR Data ステップ

•事前にSLCにインポートしていない
場合、ワークフロー内でもオリジ
ナルデータからインポートが可能
です。

•この演習ではSample Selectionの工
程をスキップしますので「Skip 
Sample Selection」パラメータは
Trueに変更し、「Next」をクリック
してください。
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DInSAR Displacementワークフロー: 演習
Interferogram Generation ステップ

干渉画像を作成ステップです。

• SARscapeではアンラップのために、軌道縞・地形縞の除去をここで行
います。

• _intという中間ファイルは、これらの情報が除去されていない画像で
す。

110

強度画像(_pwr) 干渉画像(_int) 平坦化された干渉画像
(_dint)



SARscape入門

補足:
SARscapeにおける干渉画像の作成フロー

• SARscapeでは、干渉画像の作成過程で参照DEMをインプットすることが要求されます。

• この参照DEMから「シミュレーションした地形縞」を作ることができるので、初期干渉
縞から「シミュレートした軌道縞」と併せてこれらを取り除き、干渉画像をつくります。
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除去

初期干渉縞 (*_int) シミュレートされた
地形縞

参照DEM

軌道縞と地形縞が除去された
干渉縞 (*_dint)

シミュレートされた
軌道縞

フィルタ処理や
アンラップ等の

中間処理

視線方向への変位量
（DInSARの最終結果)

InSAR DEMの場合には、この軌道縞と地形縞が除去された干渉画像に対してアンラップ工程まで進め、
再び地形縞の情報を加えてからジオコーディングを実施し、最終結果であるDEMの作成を行っている。

補足



SARscape入門

DInSAR Displacementワークフロー: 演習
Interferogram Generation ステップ

以下の設定値を入力し、左下のPreview
にチェックを入れて、「Next」をクリッ
クして次ステップへ進みます。
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【設定値】
Range Looks: 1
Azimuth Looks: 4
→変更後にEnterキーで確定させる

補足: 
Previewにチェックを入れると、以下の中間処理結果がENVIに表示されます。

INTERF_out_master_pwr: 3dec03_slcの強度画像
INTERF_out_slave_pwr: 11feb04_slcの強度画像
INTERF_out_dint: 軌道縞等の除去後のインターフェログラム画像
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DInSAR Displacementワークフロー: 演習
Adaptive Filter& Coherence Generation ステップ

コヒーレンス画像作成と、干渉画像のフィルタリ
ングのステップです。

113

本データでコヒーレンスの低い場所では、
地震前後の変化が大きかった可能性が考えられる。

コヒーレンスを計算する目的

• 測定(干渉位相)の品質を特定する
• 後方散乱係数と併せ、地上のオブジェクトに関する情報を抽出する 

ペアの各点がどのくらい似ているか、という類似度を0から1の範囲で表したもの。
1に近いほど類似度が高い。



SARscape入門

DInSAR Displacementワークフロー: 演習
Adaptive Filter& Coherence Generation ステップ

コヒーレンス画像作成と、干渉画像のフィルタリングのステップです。

114

コヒーレンス値を使用して、
様々な地物に対して個々にフィルタ処理が実行される
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DInSAR Displacementワークフロー: 演習
Adaptive Filter& Coherence Generation ステップ

パラメータはデフォルトの
「Goldstein」のまま「Next」をクリック
して次のステップへ進みます。
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補足: 
Previewにチェックを入れると、以下の中間処理結果がENVIに表示されます。
         INTERF_out_cc: コヒーレンス画像
         INTERF_out_fint: ノイズ除去後のインターフェログラム画像



SARscape入門

DInSAR Displacementワークフロー: 演習
Phase Unwrapping ステップ

• ここまでに生成された干渉画像は、各ピクセルが[-3.14, 3.14]の値(周期2π)になります。
- つまり、[-3.14, 3.14]の範囲に値が折り畳まれて(wrap)います。

• この折り畳まれている状態を解いて(unwrap) 、周期的な変化を直線的な変化に戻す処理
をアンラップといいます。
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半波長

半波長

π

-π

unwrap

unwrap

←周期的な変化

↓直線的な変化
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DInSAR Displacementワークフロー: 演習
Phase Unwrapping ステップ

以下の設定値を入力し、左下のPreview
にチェックを入れて、「Next」をクリッ
クして次ステップへ進みます。
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【設定値】
Unwrapping Method Type: Minimum Cost Flow
Unwrapping Decomposition Level: 1
Unwrapping Coherence Threshold: 0.3

補足: 
Previewにチェックを入れると、以下の中間処理結果がENVIに表示されます。
         INTERF_out_upha:フェーズアンラップ画像
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DInSAR Displacementワークフロー: 演習
GCP Selection ステップ

• 次に行うRefinement and Re-flatteningの処理に必要なGCP(Ground Control 
Point: 地上基準点)を設定します。
-干渉の色が大きく変化する箇所やコヒーレンスの低い場所は避けて取得します。

• 目的: 不動点を指定するため
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この場所は動いてない、というポイント(不動点)を指定する
約4-5点程度 (可能なら、安定構造物や動いていないことが既知の点を採用)。
軌道補正の意味もあるので、ここでも可能な限り広域で取ることが望ましい。

ここまでの工程で、既知の不動点が「動いている」と判断されている可能性がある
⚫ アンラップ画像は、周期的な位相変化を直線的な変動量に変えたもの
⚫ 本来は動いていない場所であっても、アンラップ直後の画像では動いていると計算され
てしまっている箇所もある
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DInSAR Displacementワークフロー: 演習
GCP Selection ステップ

1. 双眼鏡アイコンをクリックしてください。

2. Generate Ground Control Pointsダイアログが開きます。ファイル選択
は以下の設定値をBrowseから選択して「Next」をクリックします。
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【設定値】
Input file: INTERF_out_fint
DEM file: srtm25_dem
Reference file: INTERF_out _cc
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DInSAR Displacementワークフロー: 演習
GCP Selection ステップ

3. レイヤーマネージャの「INTERF_out_cc」を右クリックし、Change Color Table 
→ Rainbow を選択してください。

4. 「INTERF_out_fint」レイヤーを選択し、透過率を変更して、コヒーレンス画像
が見えるように設定してください。
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透過率指定のスライダー
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DInSAR Displacementワークフロー: 演習
GCP Selection ステップ

5. 以下を参考にGCPを取得します。
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✓ コヒーレンスが高く（赤く透ける
箇所）、位相情報が安定（フリン
ジを越えずある程度値が一定な箇
所）している場所をポイントとし
て設定します。

✓ ポイントを設定する際は、左マウ
スボタンで画像内の任意の場所を
クリックしてください。

✓ 画像全体に均一に3~5ポイントを
取るように設定してください。
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DInSAR Displacementワークフロー: 演習
GCP Selection ステップ

6. GCPを保存します。ポイントが取り終わりましたら、Generate Ground Control 
Points ダイアログに戻ります。Export タブでOutput XML File に任意のファイル
名を設定できます。「Finish」ボタンをクリックしてください。

7. ワークフローに戻り、Refinement GCP Fileに今作成したファイル名が入力され
ていることを確認して「Next」をクリックします。
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DInSAR Displacementワークフロー: 演習
Refinement and Re-flattening ステップ

• GCPの情報を使用して補正を行うステップです。
-フィルタ処理を行った後の干渉画像(_fint)およびアンラップ画像(_upha)に対して補正
を行った結果が表示されます。

• 使用した関数や誤差については、処理後に表示されるRefinement Result
ウィンドウに表示されます。
-中間生成物として、同様のものがtxt形式で保存されています。
-デフォルトの手法 Polynomial Refinement ではResidual Phase Poly Degreeの項目に設定
している数のGCP点が最低でも必要となる(初期値:3)

123

GCPを設定し
補正を行う
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DInSAR Displacementワークフロー: 演習
Refinement and Re-flattening ステップ

以下の設定値を入力し、左下のPreview
にチェックを入れて、「Next」をクリッ
クして次ステップへ進みます。
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【設定値】
Refinement Radius(m): 37.5
Refinement Res Phase Poly Degree: 3
Coregistration With DEM: False

補足: 
Previewにチェックを入れると、以下の中間処理結果がENVIに表示されます。
         INTERF_out_reflat_fint: リフラットしたノイズ除去干渉画像
         INTERF_out_reflat_upha:リフラットしたフェーズアンラップ画像



SARscape入門

DInSAR Displacementワークフロー: 演習
Refinement and Re-flattening ステップ

結果を確認します。
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使用された多項式近似の式と係数。
下部のRMSEなどは、インプットとして使用して
いる DEM と、多項式近似でゆがみ除去された結
果との間で計算される値で、これは、インプッ
トとして使用している DEM 自体の精度に影響を
受ける。
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DInSAR Displacementワークフロー: 演習
Phase to Displacement Conversion ステップ

•ジオコーディングした変動マップデータを作成するステップです。

•各ピクセルの値は、2時期の画像間のSARの視線方向の変動量(m)を表
します。 

-衛星に近づく方向が正、衛星から遠ざかる方向が負の値となります。
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DInSAR Displacementワークフロー: 演習
Phase to Displacement Conversion ステップ

• Phase to Displacement 
ConversionにはVertical / 
Slope Displacementという
パラメータが含まれます。

•これは視線方向の変位がす
べて水平 / 垂直方向に移動
していたとしたと仮定した
場合に理論上成り立つ水平 
/ 垂直方向の変化量を示し
たものである
-視線方向の変位量を水平/垂
直に「分解」しているわけ
ではありません。
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地盤変動 Vertical

Slope

視線方向に対する垂線
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DInSAR Displacementワークフロー: 演習
Phase to Displacement Conversion ステップ

以下の設定値を入力し、左下のPreview
にチェックを入れて、「Next」をクリッ
クして次ステップへ進みます。
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【設定値】
Product Coherence Threshold: 0.3
X Dimension (m): 25(任意)
Y Dimension (m): 25(任意)

補足: 
垂直方向やスロープ方向へ逆投影した変動結果を出力する場合はVertical 
Displacement、Slope DisplacementをTrueにしてください。



SARscape入門

DInSAR Displacementワークフロー: 演習
Output ステップ

• Output Root Nameに任意のベースファ
イル名を入力し「Finish」をクリック
します。
-Delete Temporary Filesにチェックを入れた
ままにしておくと、今までPreview用に作
成したテンポラリファイルを削除します。

-中間生成物もすべて残しておく場合には、
このチェックを外してからFinishを押して
ください。
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SARscape入門

参考: InSAR DEMワークフロー

•今回実行したDInSAR同様に、DEM作成のためのInSARワークフローも
SARscapeに搭載されています。

•詳細なステップは補足スライドにまとめてあります。
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SARscape入門

さらに学習したい人のために

弊社HPでは、SARscapeの基本操作手順書を提供しています
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 弊社HP https://www.nv5geospatialsoftware.co.jp/
ナビゲーションバー > 技術情報 > 技術資料(日本語)
> SARscape 基本操作手順書の一覧（強度画像、PS、SBAS、GCPなど）

https://www.nv5geospatialsoftware.co.jp/


SARscape入門

質疑応答

•本日のトレーニングや全体を通して、疑問点があればご質問ください。

•トレーニング終了後に思いついた質問などあれば、以下の連絡先まで
ご連絡ください。

132

NV5 Geospatial 製品・サポート連絡先
E-mail：
support_jp@NV5.com

mailto:support_jp@L3Harris.com




補足演習1:
Intensity Time Series ワークフロー



SARscape入門

SARscapeでの基本処理手順: 
Intensity Time Series ワークフロー

同じ撮影条件で得られた異なる撮影時期の
データを対象にして、以下の一連の処理を
まとめて実施するためのワークフローが用
意されています。

1. マルチルック

2. コレジストレーション

3. フィルタ

4. 時系列データの解析

5. ジオコーディング
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SARscape入門

Intensity Time Series ワークフロー: 演習

• 同一シーンの複数時期のデータを扱いますが、すべて読み込みから行うと
時間がかかりますので、既に小さなサイズに切り取ったSLCデータを利用
して処理を行います。

• 柏市から成田市あたりまでの範囲のSAR SLCデータを使用します。
2009年12月04日、 2010年04月21日、2010年06月06日
2010年07月22日、 2010年09月06日、2010年10月22日の6シーン
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SARscape入門

Intensity Time Series ワークフロー: 演習
Input ステップ

1. 表示しているデータがある場合に
は、データマネージャでファイル
を閉じてください。

2. ENVI ツールボックス → SARscape

→ Basic→ Intensity Time Series 
Workflow を選択し、ワークフロー
ダイアログを起動してください。
ワークフローダイアログは以下の
ようになります。左側にワークフ
ロー内の処理ステップのリストが
表示されます。
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SARscape入門

Intensity Time Series ワークフロー: 演習
Input ステップ

3. 以下の設定値を入力し、左下の
Previewにチェックを入れて、
「Next」をクリックして次ステッ
プへ進みます。
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Input Files:
• C:¥Training¥SARscape¥PALSAR¥SLC¥20091204_slc
• C:¥Training¥SARscape¥PALSAR¥SLC¥20100421_slc
• C:¥Training¥SARscape¥PALSAR¥SLC¥20100606_slc
• C:¥Training¥SARscape¥PALSAR¥SLC¥20100722_slc
• C:¥Training¥SARscape¥PALSAR¥SLC¥20100906_slc
• C:¥Training¥SARscape¥PALSAR¥SLC¥20101022_slc

DEM/Cartographic System:
C:¥Training¥SARscape¥PALSAR¥DEM¥srtm_dem

Parameters:
Grid Size: 6.5
Filter Method: De Grandi Spatio-Temporal



SARscape入門

Intensity Time Series ワークフロー: 演習
Import Generic SAR Dataステップ

•事前にSLCにインポートしていない
場合、ワークフロー内でもオリジ
ナルデータからインポートが可能
です。

•この演習ではSample Selectionの工
程をスキップしますので「Skip 
Sample Selection」パラメータは
Trueに変更し、「Next」をクリック
してください。
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SARscape入門

Intensity Time Series ワークフロー: 演習
Multilookingステップ

1. Principal Parametersの各項目が【設定値】の
通りであることを確認して、Previewチェッ
クボックスにチェックを入れて「Next」をク
リックします。

2. 処理が完了すると、ENVI上に*_pwrと接尾子
のついた各入力ファイルの強度画像が表示
されます。レイヤーマネージャで各レイ
ヤーを確認すると、この段階では互いに位
置にずれがあることが確認できます。
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【設定値】
Multilooking Method: Time Domain
Range Multilook: 1
Azimuth Multilook: 2
Grid Size for Suggested Looks: 6.5



SARscape入門

Intensity Time Series ワークフロー: 演習
Coregistraionステップ

1. Principal Parametersの各項目が【設定
値】の通りであることを確認して、
Previewチェックボックスにチェック
を入れて「Next」をクリックします。

2. 処理が完了すると、 ENVI上に*_rspと
接尾子のついた各強度画像の位置合
わせされた画像群が表示されます。
レイヤーマネージャの表示/非表示切
り替えや透過度を変更して各レイ
ヤーの位置にずれがなくなったこと
を確認してください。
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【設定値】
Coregistration With DEM: False



SARscape入門

Intensity Time Series ワークフロー: 演習
De Grandi Spatial-Temporal Filtering ステップ

1. Principal Parametersの各項目はデフォ
ルト設定のまま、Previewチェック
ボックスにチェックを入れて
「Next」をクリックします。

2. 処理が完了すると、ENVI上に*_filと接
尾子のついた位置合わせされた各強
度画像のフィルタリングされた画像
群が表示されます。レイヤーマネー
ジャの表示/非表示切り替えや透過度
を変更して同一日付の*_rspと*_filの
ペアを比較しましょう。河川の部分
など、ごま塩状のスペックルノイズ
が軽減されていることがわかります。
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SARscape入門

Intensity Time Series ワークフロー: 演習
Geocoding and Radiometric Calibration ステップ

1. パラメータはデフォルトのまま
「Next」をクリックしてください。

2. 処理が完了すると、ENVI上に*_geo
と接尾子のついたジオコーディン
グされた画像群が表示されます。
ENVIのステータスバーに地理情報
が表示されていることが確認でき
ます。
✓SAR画像に付加される投影情報はDEM
データが持つ投影情報となります。
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SARscape入門

Intensity Time Series ワークフロー: 演習
Multi Temporal Features ステップ

入力した時系列SARデータの統計計算
など特徴抽出します。

1. パラメータはデフォルトのまま
「Next」をクリックしてください。
✓Make cmg RGBフラグこのフラグを設定
すると、以下をRGB合成画像として生
成してくれます。(デフォルト:True)

✓変動係数 (Coefficient of Variation)

✓最小値 (Min)

✓勾配 (Gradient)
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SARscape入門

Intensity Time Series ワークフロー: 演習
Output ステップ

• Output Root Nameに任意のベースファ
イル名を入力し「Finish」をクリック
します。
-Delete Temporary Filesにチェックを入れた
ままにしておくと、今までPreview用に作
成したテンポラリファイルを削除します。

-中間生成物もすべて残しておく場合には、
このチェックを外してからFinishを押して
ください。
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SARscape入門

Intensity Time Series ワークフロー: 結果確認

処理が完了すると、レイヤーマネージャにあった中間ファイルは削
除され、出力した*_mt_feature_metaファイルが表示されます。

• Make cmg RGBがTrueになっていると、Coefficient of Variation, Min, 
Gradient をRGBに割り当てたTIFFが作成されます。

• *_metaファイルには、Band1～Band6までに各日付のジオコー
ディング画像と、Band7以降にMulti-Temporal Featuresで設定した
バンドが含まれています。
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SARscape入門

Intensity Time Series ワークフロー: 結果確認

intensity_CovMinGrad_rgb.tifファイルを確認します。
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SARscape入門

Intensity Time Series ワークフロー: 結果確認

intensity_CovMinGrad_rgb.tifファイルを確認します。
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変動係数(Coefficient of 
Variation)

最小値(Min)

勾配(Gradient)



SARscape入門

Intensity Time Series ワークフロー: 結果確認

intensity_CovMinGrad_rgb.tifファイルを確認します。
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変動係数(Coefficient of 
Variation)

最小値(Min)

勾配(Gradient)

• 標準偏差 / 平均値 → 時系列的なばらつきの大きさ
• 水田といった時間毎に著しく変化していく場所では、こ
の値が大きくなります。

変動係数:



SARscape入門

Intensity Time Series ワークフロー: 結果確認

intensity_CovMinGrad_rgb.tifファイルを確認します。
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変動係数(Coefficient of 
Variation)

最小値(Min)

勾配(Gradient)

• 入力期間での最小値
• 強い反射を示す建物といった構造物では、最小値自体が
ほかの対象物よりも大きな値を示します。

最小値:



SARscape入門

Intensity Time Series ワークフロー: 結果確認

intensity_CovMinGrad_rgb.tifファイルを確認します。
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変動係数(Coefficient of 
Variation)

最小値(Min)

勾配(Gradient)

• 連続する2時期での最大となる変動量
• 時期データ間の変化が大きい場所では、この値が大きく
なります。

勾配:



補足演習2:
InSAR DEMワークフロー



SARscape入門

処理の概要

SAR画像ペアからインターフェログラム（干渉画
像）を作成しDEM作成まで一連の処理を実行しま
す。

1. インターフェログラムの作成

2. コヒーレンス画像作成と干渉フィルタ

3. 位相のアンラップ処理

4. 軌道補正と位相のオフセット計算

5. 標高データ(DEM)の作成
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SARscape入門

使用するデータについて

ビーバーダムウォッシュ国立保護区周辺のENVISAT ASAR IS4 データ

•撮影時期: 2002 年11月7日 / 2003年1月16日 のペア

•本トレーニング使用するデータはすでにSARscapeへインポート済み
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The Bureau of Land Management
https://www.blm.gov/visit/beaver-dam-wash-national-conservation-area

https://www.blm.gov/visit/beaver-dam-wash-national-conservation-area


SARscape入門

Preferences specificの変更

•先ほどの演習でSentinel TOPSAR (IW - EW)を
使用していたので、ここではGeneralとい
う設定に変更してください。
- /SARscape/Preferences/Preferences specific
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SARscape入門

Baseline Estimationの確認

1. ENVI ツールボックス → SARscape → Interferometry → Interferometric 
Tools → Baseline Estimationを選択し、設定ダイアログを起動します。

2. Input FilesタブにReferenceおよびSecondaryのファイルを設定し、
Execボタンで実行します。
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【設定値】
Input Fileタブ
Input Reference File:

C:¥Training¥SARscape¥reference¥InSAR_Input¥DORIS¥7_11_02_slc
Input Secondary File:

C:¥Training¥SARscape¥reference¥InSAR_Input¥DORIS¥16_01_03_slc



SARscape入門

Baseline Estimationの確認

出力結果を確認します。
⚫Normal Baseline（垂直方向の距離）がCritical Baseline（臨界ベースライ
ン）の距離に収まっているか確認します。
⚫Critical BaselineよりNormal Baselineが大きくなった場合は、位相情報が大
きく異なるため、二つの画像を干渉させ、インターフェロメトリの処理を
行うことができません。
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干渉するための臨界ベースラインが
±1418.164[m]に対し、両者のノーマル
ベースラインが116.530[m]であるので、
このペアは干渉できるペアとわかる。



SARscape入門

InSAR DEMワークフロー: 演習
Input ステップ

1. ENVI ツールボックス → SARscape → Interferometry 
→ InSAR DEM Workflowを選択し、InSARワークフ
ローダイアログを起動してください。
✓ツールボックスの検索機能は使用しないでください。先に
検出されたツール名のものが優先表示され、GCP取得の工
程が省略された方のInSAR DEM Workflowが起動されてしま
います。

2. Inputダイアログの設定は以下のようになります。設
定を確認し、Nextボタンで先に進めます。
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Input Fileタブ
Reference File: 

C:¥Training¥SARscape¥reference¥InSAR_Input¥DORIS¥7_11_02_slc
Secondary File: 

C:¥Training¥SARscape¥reference¥InSAR_Input¥DORIS¥16_01_03_slc

DEM/Cartographic Systemタブ
DEM file: C:¥Training¥SARscape¥reference¥InSAR_Input¥start_dem

Parametersタブ
Grid Size: 25.0

Next>>>は押さないでください。
対話的な処理が必要な工程まで、要求されるまで処
理が一気に進んでしまいます。



SARscape入門

InSAR DEMワークフロー: 演習
Import Generic SAR Data ステップ

•事前にSLCにインポートしていない
場合、ワークフロー内でもオリジ
ナルデータからインポートが可能
です。

•この演習ではSample Selectionの工
程をスキップしますので「Skip 
Sample Selection」パラメータは
Trueに変更し、「Next」をクリック
してください。
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SARscape入門

InSAR DEMワークフロー: 演習
Interferogram Generation ステップ

干渉画像を作成ステップです。

• SARscapeではアンラップのために、軌道縞・地形縞の除去をここで行
います。

• _intという中間ファイルは、これらの情報が除去されていない画像で
す。
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強度画像(_pwr) 干渉画像(_int)
平坦化された干渉画像

(_dint)



SARscape入門

InSAR DEMワークフロー: 演習
Interferogram Generation ステップ

以下の設定値を入力し、左下のPreview
にチェックを入れて、「Next」をクリッ
クして次ステップへ進みます。
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【設定値】
Range Looks: 1
Azimuth Looks: 4
→変更後にEnterキーで確定させる

補足: 
Previewにチェックを入れると、以下の中間処理結果がENVIに表示されます。

INTERF_out_master_pwr: 7_11_02_slcの強度画像
INTERF_out_slave_pwr: 16_01_03_slcの強度画像
INTERF_out_dint: 軌道縞等の除去後のインターフェログラム画像



SARscape入門

InSAR DEMワークフロー: 演習
Adaptive Filter& Coherence Generation ステップ

コヒーレンス画像作成と、干渉画像のフィルタリ
ングのステップです。

162

本データでコヒーレンスの低い場所は、
Google Earthで確認すると、未舗装の道路だった。

コヒーレンスを計算する目的

• 測定(干渉位相)の品質を特定する
• 後方散乱係数と併せ、地上のオブジェクトに関する情報を抽出する 

ペアの各点がどのくらい似ているか、という類似度を0から1の範囲で表したもの。
1に近いほど類似度が高い。



SARscape入門

InSAR DEMワークフロー: 演習
Adaptive Filter& Coherence Generation ステップ

コヒーレンス画像作成と、干渉画像のフィルタリングのステップです。
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コヒーレンス値を使用して、
様々な地物に対して個々にフィルタ処理が実行される



SARscape入門

InSAR DEMワークフロー: 演習
Adaptive Filter& Coherence Generation ステップ

パラメータはデフォルトの
「Goldstein」のまま「Next」をクリック
して次のステップへ進みます。
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補足: 
Previewにチェックを入れると、以下の中間処理結果がENVIに表示されます。
         INTERF_out_cc: コヒーレンス画像

INTERF_out_fint: ノイズ除去後のインターフェログラム画像



SARscape入門

InSAR DEMワークフロー: 演習
Phase Unwrapping ステップ

• ここまでに生成された干渉画像は、各ピクセルが[-3.14, 3.14]の値(周期2π)になります。
- つまり、[-3.14, 3.14]の範囲に値が折り畳まれて(wrap)います。

• この折り畳まれている状態を解いて(unwrap) 、周期的な変化を直線的な変化に戻す処理
をアンラップといいます。
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半波長

半波長

π

-π

unwrap

unwrap

←周期的な変化

↓直線的な変化



SARscape入門

InSAR DEMワークフロー: 演習
Phase Unwrapping ステップ

以下の設定値を入力し、左下のPreview
にチェックを入れて、「Next」をクリッ
クして次ステップへ進みます。
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【設定値】
Unwrapping Method Type: Minimum Cost Flow
Unwrapping Decomposition Level: 1
Unwrapping Coherence Threshold: 0.3

補足: 
Previewにチェックを入れると、以下の中間処理結果がENVIに表示されます。
         INTERF_out_upha:フェーズアンラップ画像



SARscape入門

InSAR DEMワークフロー: 演習
GCP Selection ステップ

• 次に行うRefinement and Re-flatteningの処理に必要なGCP(Ground Control 
Point: 地上基準点)を設定します。
-干渉の色が大きく変化する箇所やコヒーレンスの低い場所は避けて取得します。

• 目的: 参照DEMで取りきれないノイズの除去と軌道補正のため
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干渉SARの結果に手動で位置情報を与え、これらの誤差を除去する
広く画像全体で、およそ20点程度のGCPを取得する

地形情報(DEM)を求める際に含まれる誤差の原因
⚫ 大気中には水蒸気などの微粒子があることで、位相遅延の原因になる
⚫ 使用した衛星ペアは完全に平行な軌道で同じ場所を観測してはいないため、相対的なズ
レがどうしても含まれる



SARscape入門

InSAR DEMワークフロー: 演習
GCP Selection ステップ

1. 双眼鏡アイコンをクリックしてください。

2. Generate Ground Control Pointsダイアログが開きます。ファイル選択
は以下の設定値をBrowseから選択して「Next」をクリックします。
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【設定値】
Input file: INTERF_out_fint
DEM file: start_dem
Reference file: INTERF_out _cc



SARscape入門

InSAR DEMワークフロー: 演習
GCP Selection ステップ

3. レイヤーマネージャの「INTERF_out_cc」を右クリックし、Change Color Table 
→ Rainbow を選択してください。

4. 「INTERF_out_fint」レイヤーを選択し、透過率を変更して、コヒーレンス画像
が見えるように設定してください。
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透過率指定のスライダー



SARscape入門

InSAR DEMワークフロー: 演習
GCP Selection ステップ

5. 以下を参考にGCPを取得します。

170

✓ コヒーレンスが高く（赤く透ける
箇所）、位相情報が安定（フリン
ジを越えずある程度値が一定な箇
所）している場所をポイントとし
て設定します。

✓ ポイントを設定する際は、左マウ
スボタンで画像内の任意の場所を
クリックしてください。

✓ 画像全体に均一に10ポイントを取
るように設定してください。



SARscape入門

InSAR DEMワークフロー: 演習
GCP Selection ステップ

6. GCPを保存します。ポイントが取り終わりましたら、Generate Ground Control 
Points ダイアログに戻ります。Export タブでOutput XML File に任意のファイル
名を設定できます。「Finish」ボタンをクリックしてください。

7. ワークフローに戻り、Refinement GCP Fileに今作成したファイル名が入力され
ていることを確認して「Next」をクリックします。
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SARscape入門

InSAR DEMワークフロー: 演習
Refinement and Re-flattening ステップ

• GCPの情報を使用して補正を行うステップです。
-フィルタ処理を行った後の干渉画像(_fint)およびアンラップ画像(_upha)に対して補正
を行った結果が表示されます。

• 使用した関数や誤差については、処理後に表示されるRefinement Result
ウィンドウに表示されます。
-中間生成物として、同様のものがtxt形式で保存されています。
-デフォルトの手法 Polynomial Refinement ではResidual Phase Poly Degreeの項目に設定
している数のGCP点が最低でも必要となる(初期値:3)
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GCPを設定し
補正を行う



SARscape入門

InSAR DEMワークフロー: 演習
Refinement and Re-flattening ステップ

以下の設定値を入力し、左下のPreview
にチェックを入れて、「Next」をクリッ
クして次ステップへ進みます。
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【設定値】
Refinement Radius(m): 37.5
Refinement Res Phase Poly Degree: 3
Coregistration With DEM: False

補足: 
Previewにチェックを入れると、以下の中間処理結果がENVIに表示されます。
         INTERF_out_reflat_fint: リフラットしたノイズ除去干渉画像
         INTERF_out_reflat_upha:リフラットしたフェーズアンラップ画像



SARscape入門

InSAR DEMワークフロー: 演習
Refinement and Re-flattening ステップ

結果を確認します。

174

使用された多項式近似の式と係数。
下部のRMSEなどは、インプットとして使用して
いる DEM と、多項式近似でゆがみ除去された結
果との間で計算される値で、これは、インプッ
トとして使用している DEM 自体の精度に影響を
受ける。



SARscape入門

InSAR DEMワークフロー: 演習
Phase to Height Conversion ステップ

•位相差を高さ情報に変換するステップです。

•ジオコーディングした標高データ（DEM）が作成されます。
-Output TypeがEllipsoidal(デフォルト値)だと楕円体高で、Ellipsoidal and Geoidal
だと楕円体高と標高値の双方で出力されます。
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SARscape入門

InSAR DEMワークフロー: 演習
Phase to Displacement Conversion ステップ

以下の設定値を入力し、左下のPreview
にチェックを入れて、「Next」をクリッ
クして次ステップへ進みます。
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【設定値】
Product Coherence Threshold: 0.3
X Dimension (m): 25(任意)
Y Dimension (m): 25(任意)



SARscape入門

InSAR DEMワークフロー: 演習
Output ステップ

• Output Root Nameに任意のベースファ
イル名を入力し「Finish」をクリック
します。
-Delete Temporary Filesにチェックを入れた
ままにしておくと、今までPreview用に作
成したテンポラリファイルを削除します。

-中間生成物もすべて残しておく場合には、
このチェックを外してからFinishを押して
ください。
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補足: 
DEMファイルと同時に出力ディレクトリには*_precisionファイルと*_resolution
ファイルが作成されます。
• *_precisionファイルはDEMデータの各ピクセルの信頼度を示し、低い値を

持つピクセルが信頼度の高いデータとなります。
• *_resolutionファイルは、入射角角に基づいた各ピクセルの解像度となりま

す。



SARscape入門

InSAR DEMワークフロー: 結果の確認

使用したsrtm_demと並べて、結果を比較してみてください。
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